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For more details see the Product Attachments extension page.

Guide for Product Attachments for Magento
2

Provide customers with additional details about the products they purchase in your store. The
extension allows you to add manuals, licenses, warranties and other downloadable information right
on product pages. Equip your attachments of any format with catchy icons to attract customers'
attention.

e Upload the unlimited number of attachments
e Support for any file types

e Track attachments downloads

e Equip files with catchy icons

Configuration

To configure general extension settings please go to Stores —» Configuration - Amasty
Extensions - Product Attachments.

General Settings

Expand the General tab.
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Configuration A demouser -
Store View:  Default Config - e
General )

Enal}le_ Mndulg

fes -

Add Category Files to
Yes v
Products o

Display “Include In
Order” Files on Product | Mo v
Pages and Widgets

B e

i,

‘Haah

See your store performance in details with the Magento 2 Advanced Reports.

Url C reat_i:_rl'l_;T}.rfg id

e

Enable Module - enable or disable the extension by clicking 'Yes' or 'No'.

Add Category Files to Products - if YES, the files will be attached to all category products. If NO,
the files will not be attached to the products of the category. But you can display the category
attachments with the help of widget.

Display "Include In Order’ Files on Product Pages and Widgets - enable this option if you want
to show files regarding ordered products on product pages and widgets.

Url Creation Type - select the type of URL that will be applied to the attachments: ID or Hash.
ID type URL example:
http://domain.zone/amfile/download/file/22

Hash type URL example:

http://domain.zone/amfile/download/file/8a9e07bad0166438b0

Product Tab
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Configuration L demouser ~
Store View:  Default Config = 9
Product Tab ®

Show " Product Attachments”

Yas v
Tah
[store view] A new tab with product attachments will be added
to product tabs on a Product Fage

.Tf-"'_b_T'El_E. Product Attachments

Choose Customer Groups to
show the Tab

L5t General

MNOT LOGGED 1M

Wholesale

Retailer

4

Don't choose any or select all to show the tab to all
CUSIOMEr groups.

Show File lcon

Yes -

Show_ _If|_|_e: Sl;z_e_ Vas r

Tah_ﬁ?im?.r_. <5

Show "Product Attachments™ Tab - enable display of a new tab with product attachments in the
description block on a Product Page.

Tab Title - specify the name for the tab with product attachments.

Choose Customer Groups to show the Tab - specify customer groups for which the attachments
will be visible.

Show File Icon - make attachments more noticeable by showing file icons or turn off this option if
needed.

Show File Size - enable this option to let your customers know about the size of the attachment.
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Tab Position - specify the position for the product attachments among the other tabs.

To maintain the correct tabs display, please do NOT set the multiples of 10 (0,10,20, etc.). You may
choose the following ranges: 11-19, 21-29, etc. or use the numbers that contain 5 (5, 15, 25, etc.).

Order View Page
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Configuration 4. demouser -

Store View:  Default Config « 9

General S

Product Tab =)

Order View Page @
Show Attaé t'ljr‘r;elr; ts Vas .

Title for Attachments Block
[store view]

Type of Attachments t? Display |- |nclude In Order” Only .
SLOre Wew)
“Include In Order™ Only
All Product Attachments
Order Status

[store view] Pending

Product Attachments

Processing

Suspacted Fraud

Complete
Closed
Canceled
On Hold
e
Leave the field empty to show attachments in
all statuses
Show File Icon
[store view] Vs M
Show File Size |, -

[store view]

Show Attachments - enable this option if you want to show attachments for ordered products.

Title for Attachments Block - specify the title for attachments block on the Order View Page.
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Type of Attachments to Display - show all product attachments or include them to the order only.

Order Status - choose order status according to which the attachments will be displayed. It is useful
if you want to show files only when a purchase is completed.

Show or Hide File Icon and File Size.

Order Email
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Configuration L demouser -
Store View:  Default Config + 9 Save Config
General ©)

Product Tab @)
Order View Page )

_—

Order Email

P
H

p

Add Attachments to
Transactional Emails

Yes A

Title for Attachments Product Attachments
i L ¢ =)

Block
Type of Attachments to “Include In Order™ Only v
Add
Order Status
[store view] Pending
Frocessing

Suspected Fraud
Complete
Closed

Canceled

On Hold
Leave the field empty to show attachments in all statuses

Add Attachments to Transactional Emails - include files to transactional emails to provide
customers with the maximally detailed product description.

Title for Attachments Block - specify the title of the block that will be displayed in emails.

Type of Attachments to Add - add all the attachments or ‘Include in Order’ only to your
transactional emails.

Order Status - select the status(es) that the orders must have to show attachments. Leave the field
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empty to show attachments in all statuses.

Additional Settings

Configuration A demouser -

Store View:  Default Config - 0 Save Config

Additional Settings

Autodetect File Mime Type on Download Ves v

e

Set the option to Yes to let customers open attachments in a new
orowser window instead of downloading them. ‘Fileinfo'
extension or ‘mime_content_type’ function must be enabled in
server configuration

Autodetect File Mime Type on Download - set the option to 'Yes' to let customers open
attachments in a new browser window instead of downloading them.

Adding Files to the Product

To add new files for a specific product please go to Catalog - Products and open the necessary
product. Then expand the Product Attachments tab.
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Product Attachments .~ =

Include In

Fileld | lcon | File Name Extension | Label Customer Groups Order Visible Actions

M e docx L ) .
o = bag-warranty_3 bag-warranty_3 MOT LOGGED IN RN @RC
- SrMera
Genera 'i'
Wholesale
Retaile .
HEW - 2 BICTT 1 O B B ,
o Y promo-bag_2 IP8 promo-bag_2 NOT LOGGED [N vo | ) Yes
Genera 'i'
Wholesale
Retailer

Add Existing Attachments Add New Files Add New Links

You can specify custom name for this tab by modifying the Tab Title option on the General Settings
page.

This handy grid allows you to manage all existing attachments easily:

Icon - define a needed attachment by catchy icons to add to the product.

File Name - specify a relevant file name for your internal use.

Extension - track the attachments easily according to file extensions.

Label - fill in the label that will be displayed on the frontend as the name of the attachment.
Customer Group - specify a customer group for which the attachment will be visible on the frontend.

Include In Order - enable this option if you want to display the product attachment in the tab 'My
Orders' on the frontend.

Visible - modify this option to hide or display the attachment regarding the product.
If you show two or more attachments on a product page, you can specify the order for displaying files.
You can make the following actions right from the admin panel:

Click the Add Existing Attachments button to add files that are already loaded. Click the Add New
Files button to add a new attachment for the related product. Click the Add New Links button to
provide your product page with a necessary link.
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Attachments Management

To see all the attachments please go to Catalog -» Attachments Management.

Attachments Management Q A admin ~

W Filters OG> DefaultView - -ﬂ- Columns -

Actions s 20 > |perpage 1 of 1

Delete

File Name File Label Mime Type —
Edit user_manua user_manua application/ 11.64 | Apri, Apri,
— vnd.openxml kB 2020 2020
8:17:23 8:17:23
A AM
Edit watches- watches- text/plain 8.00 Apri, Apr,
o — warranty warranty B 2020 2020
8:17:23 8:17:23
AM AM
Edit ) promo-bags promo-bags image/jpeg 84.92 | Apri, Apri,
v, adk kB 2020 2020
8:17:23 8:17:23
AM AM
Edit . promo-watches | promo-watches | imagefjpeg 27.74 | Apr1, Apr1,
adk kB 2020 2020
8:17:23 8:17:23
AM AM
Edit product- product- application/zip | 26.98 | Apr1, Apri,
!l attachments attachments kB 2020 2020
8:17:23 81723
AM AM

This handy grid helps you track all existing files by ID, icon, attachment type, file name, file label,
mime type, and file size. Also, store admins can track the date of file upload and monitor the date of
last changes (including changes of products, categories, etc.).

You can add new files to the existing list right from the grid by clicking the Add New Attachment
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button.

New Attachment L cemouser +

“« Back Save and Continue Edit Save Attachment

File Info Fields

Attachment Type File b

File Upload
A
—

bag-warranty_5.docx

Attachment Mame * | bag-warranty_5
Label * | bag-warranty S

Customer Groups MOT LOGGED IN
General
Whaolesale

Retailer

7

Don't choose any or select all to show the attachment to all customer groups.
Isvisible @ ) ves

Include In Order Mo

Include this attachment inte crder transactional email and show in the view
order’ section of customer's account.

Specify the Attachment Type and fill in the Attachment Name, Label and then choose a
Customer group to which display the file. Then press the Upload button to select a necessary file.

In one click you can regulate the file visibility and include it in order.
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Attach To

Categories Gear x| Bags x .
Add products
1 of 1
ID | Thumbnail  MName Status Type SKU Price Actions

1

Joust Duffle Bag Enabled | simple : 24- $34.00 Remave
ii MBO1

2 Strive Shoulder Pack Enabled = simple : 24- $32.00 Remove
‘ MBO4

Also you can attach a new file to any category and product you need. Just select necessary categories
and add products to attach a new file to them.

Then press the Save Attachment button to finish the new attachment adding.

Adding an Icon

Make attachments more noticeable for customers with catchy icons. To create a new attachment icon
or edit already existing ones go to Catalog - Icon Management.
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lcon Management L. cemovser ~
Add New Icon
Y Filters > Default View = £ Columns -
Actions | ™ 15 records found 20 ¥ | per page 1 of 1
HE3 D | | Thumbnail | Type Extensions Status Action
1 Document doc, docx, t, rif, pdf, djvu Enabled Edit
2 Image iPE: ipeg: png, gif, bmp Enabled Edit
.
vy
3 Yideo avi, mp4 Enabled Edit
4 Audio mp3, jpeg. 0gg Enabled Edit
3 Archive zip, rar, 7z Enabled Edit
i Table 5w, xls, xlsx Enabled Edit
7 Presentation pptx, pptm, ppt Enabled Edit
8 Scheme ini Enabled Edit

&

This handy grid allows you to track all existing files by thumbnail, icon type and extension. You can
easily check the icon status in the same place.

The module let you add a new icon right from the admin panel by pressing the Add New Icon button.
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New |lcon

&« Back

Product Attachment lcon

lcon Upload

Type * [ Image

Enabled ( Yes

File Extensions

File Extension *
png

Add Extension

1 gemouser -

Save and Continue Edit m

Actions

s
]

Upload the icon you need, specify the file type for which the icon will be used. You can enable the icon
displaying in one click. Then add the file extension by pressing the Add Extension button.

Hit the Save Icon button to finish the new icon adding.

Adding Files to the Product Category

To attach files to any product category, please, go to Catalog - Categories and select any product

category to which you want to add files.
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Gear (46
Bags (14)
Fitness Equipment (23) Category Name *  Bags

Warches (3)

Traning (€) Products in Category @

Sale (0)

Design ®

Schedule Design Update

Product Attachments ~
of 1
Fil Attach t - . -
Irji ®  lcon Na:e men Extension  Label Customer Groups Include In Order Visible Actions
24 txt e — »
- Warranty 8 Warranty NOT LOGGED IN ( Yes .( Yes
Use Use General Use Default Use Default
Default Default Wholesale Value Value i
Value Value
Retaller
Use Default Value
2 Y proma.|pg IPE promo.pg NOT LOGGED IN No ( Yes
use use General Use Default Use Default
Default Default whalesale Value Value ﬁ
Value Value
Retailer

Use Default Value

Then, expand the Product Attachments tab. You can add existing or new files or even add new links
to the chosen product category. Then press the Save button to attach added files to the certain
product category.

Managing Attachments Block via Widget

With the extension it is possible to add Product Attachments Block to any page or position via widget.

To configure the widget, go to Content -» Elements -» Widgets.
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W|dget5 L demouser ~

Add Widget
Reset Filter 19 records found

20 v | perpage - 1 of 1

Widget ID Sort Order

v kL

1 Contact us info CMS Static Block Magento ]
Luma

2 Footer Links CMS Static Block Magento ]
Luma

3 Sale Left Menu CMS Static Block Magento ]
Luma

4 Gear Left Menu CMS Static Block Magento ]
Luma

5 Men's Left Menu CMS Static Block Magento ]
Luma

6 Women's Left Menu CMS Static Block Magento ]
Luma

7 What's Mew Left Menu CMS Static Block Magento ]
Luma

8 Women Category CMS Static Block Magento ]
Content Luma

5 Training Category CMS Static Block Magento ]
Content Luma

Click the Add Widget button.

amasty


https://amasty.com

Last update: 2020/04/04 14:02  magento_2:product_attachments https://amasty.com/docs/doku.php?id=magento_2:product_attachments

WldgEtS X demouser ~
€« Back Reset
WIDGET _
Settings
Settings  # Type * | Amasty Attachments Block -

-- Please Select --
CMS Page Link

CMS Static Block

Catalog Category Link
Catalog New Products List
Catalog Product Link
Catalog Products List

Orders and Returns
Recently Compared Products
Recently Viewed Products

Design

* -
Theme Magento Luma

Continue

Type - select the Amasty Attachments Block widget type.
Choose the theme and click Continue.

Set the Storefront Properties of the block.
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W|dgEtS L demouser ~

& Back Reset Save and Continue Edit E

WIDGET )
Storefront Properties
Storefront Type Amashy Atta e
Properties
g
Design ;
Package/T )
Widget heme
Options
W'd.EEt * | Product Attachments
Title

Assign to
Store All Store Views 9

Views * | Main Website

Main Website Store

Dafault Store View

NewWeb5Sait

MNewstore

Hewstoreview

Sort

Order .

Sort Order of widget instances in the same container
Widget Title - specify the title for the internal usage.
Assign to Store Views - select store views where the widget should be displayed.
Sort Order - set the position of the block in the same container.

In the Layout Updates section you can set any category or product page to display the widget.
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Layout Updates

Display on | Anchor Categories v
Categories Container Template

All . . e e i
. 5|debarlé.|d|:||[|.:)na| - Please Select Container Firs

Specific Categories

Display on | All Product Types v
Products Container Template
All - Please Select Container Firs
Page Footer r edse Select Container First

® Specific Products

L i '-Q
Display on | Specified Page v
Fage Container Template
] Please Select Container
Catalog Product Cor | = Sidebar Main | =

First

Add Layout Update

Specify the particular categories or products if necessary. In the Container dropdown menu choose
where attachments block should be placed. Add as many pages and positions as you need.

Expand the Widget Options tab.

amasty


https://amasty.com

2020/04/04 15:20 21/78 Guide for Product Attachments for Magento 2
WldgEtS L demouser ~
€& Back Reset Save and Continue Edit E

WIDGET

Storefront
Properties #

Widget Options
rd

Widget Options

Block Title

Widget
Type

Show lcon

Show File
Size

Product Attachments

Current Category |
Current Category

Specific Category
Current Product

Specific Product

Custom Files

fas A

as v

Block Title - specify the title that will be displayed on the frontend.

Widget Type - choose the type of the widget.

You can also Show Icon and Show File Size or hide them if necessary.

Hit the Save button.

Download Reports

Due to the advanced Magento 2 file attachment manager tool you can view and analyze detailed
reports on file downloads. Here you can see statistics on what attachments were downloaded, when

this happened and who downloaded the file.

To see reports on file downloads please go to Reports - Downloads.
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Product Attachment Report Downloads L. cemouser =
Y Filters > Default View = ﬁ' Columns =
13 records found 20 ¥ |per page 1 of 1
File ID File Name Store View Download Source Downloaded At T
- warranty. it Default store View Froduct Jan 22, 2019 Z:44:53 PM
6 user_manual pdf Default Store View Product Jan 22, 2019 2:44:50 PM
3 promo.pg Default store View Froduct Jan 22, 2019 Z:44:45 PM
2 promo.jpg Default Store View Other |an 22, 2019 2:41:47 PM
1 Warranty. it Default 5tare View Other |an 22, 2019 Z:41:42 PM
24 Warranty Default Store View Category |an 17, 2019 1:06:29 PM
5 promao jpg Default 5tare View Mow 30, 2016 3:15:43 PM
6 user_manual.pdf Default Store View Mov 30, 2016 3:12:40 PM
5 promo.jpg Default 5tore View Mow 30, 2016 312:22 PM
- warranty.txt Default Store View Mov 30, 2016 3:12:17 PM
i user_manual pdf Default 5tore View Mow 30, 2016 2:23:14 PM
5 proma.jpg Default Store View Mowv 30, 2016 2:22:46 PM
- warranty. it Default Store View Mow 30, 2016 2:22:34 PM

In case you want to refresh the reports download history, click the Clear File Downloads button.

Show Attachments on the Product Page

You can place attachments in the product description block via widgets.
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Home »  SummitWatch

[i]

Details Product Attachments More Information
=| warranty.txt

A promo.jpg

=| user_manual.pdf

Add Attachments to Orders

Summit Watch

& 8 3 Reviews Add Your Review

IN STOCK
$54' 00 SEU#: 24-MGO3

Qty

Add to Cart

W ADD TO WISH LIST  .ls ADD TO COMPARE
B EMAIL

VIEWS (3}

Customers can find all attachments regarding completed orders in their accounts. When they view a
necessary order in the tab ‘My Orders’, they find corresponded files. All this prevents from losing
important documentation regarding the purchased product and its usage.
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womons Order # 000000003 e

January 31, 2013

Reorder Pr

tems Ordered

Product Name SKU Price Qty Subtotal

Stored Payment Methods
Bl e e summit Watch 24-MG03 $54.00 Ordered: 1 $54.00

Product Attachments
My Product Reviews
: =| wuser_manual.pdf

MNewsletter Subscriptions

Subtotal $54.00

Shipping & Handling $5.00

Compare Products Tax $4.46
Grand Total $63.46

You have no items to compare.

The extension allows you to place attachments in absolutely any location on product, category and
CMS pages via widgets.

Attachments mass-import

With the extension you can import attachments in bulk and assign them to products via CSV-file
import.

Go to Catalog, choose Mass File Import in Product Attachments tab.
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i demouser -
Mass File Import 1
W Filters > DefaultView - £+ Columns ¥
Actions | = | 3 records found 20 ~ | per pags 1 of 1
HE © ! | Created Date Action
1 May 11, 2019 1:27:23 PM Continue
2 May 15, 2019 7:12:33 AM Continue
3 May 15, 2019 7:58:05 AM Continue

All incomplete imports are saved and displayed in the grid. To complete any of them, press the
Continue button. To start a new import process, click New Import.

Step 1. Prepare files for import

In this tab upload all the attachments you want to import via Add New File button.

You can also upload your files in pub/media/amasty/amfile/import/ftp folder.
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Upload Your Files A cemouser v
o Cancel Ba m
Prepare Files Select Stores Impaort Your
For Import Far Files
Configuration

Prepare Files

You can upload your files in pub/media/amasty/amfile/import/ftp folder

Attachment Extension | Label Customer Groups I[;‘I:,[::EE in Visible

MName

1 = tee-tank Ipg tee-tal NOT LOGGED IM g v @ ) v

General

L

Wholesale

Retailer

402 Bri | POF 402 E NOT LOGGED IN no (@) ves

General

o

Wholesale

Retailer

L

— DMC-Fi pdf DMCF NOT LOGGED IN Q€ v @)

General

mp

Wholesale

Retailer

- Renusol | | Pdf Renus NOT LOGGED IN No (@) ves

General

i

Wholesale

Retailer

Add Mew Files

You can change files' names and labels if needed, assign them to the necessary customer groups,
include in order and make them visible/invisible right in the grid.

Click Next.
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Step 2. Select Stores For Configuration

Here specify store views to which you want to import files.

Select Stores For Configuration

Prepare Files Select Stores Import Your
For Import For Files

Configuration

Configurate Your Stores

Select Store Views * | Main Website
Main Website Store

Default Store View
MNewWeb5Sait
MNewStore

MewStoreview

Press Next.
Step 3. Import Your Files

In this tab CSV-file is generated.

Cancel

Back

X demouser
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Import Attachments L demouser +

(1 D e

Prepare Files Select Stores Import Your
For Import For Files
Configuration

Cancel 4

Back Mext

Import Settings

Generate Import File

Import Behavior

Import Behavior * | Add - |
. Stop on Error - |
Allowed Errors Count * | 10 |

Please specify number of errors to halt impaort process

Field separator * | , |

Multiple value separator * ‘ , ‘

Fields enclosure

File to Import

Select File to Import * Choose File | Mo file chosen

Images File Directory |

For Type "Local Server” use relative path to Magento installation,
£.5. varfexport, var/import, varfexport/somedir
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Press Generate import file to download an import sample file.

In the sample you can edit any data presented in Step 1.

L23 - g

A B
m—m—m—m——-m—-m—

1 1 0 tee-tank tee-tankl 14,21

1 1 1

1 1 2

2 1 0 4.02_Britex_TPW 4.02_Britex_TPW 0,3 1 [H] & 32,34
2 1 1

2 1 2

3 1 0 DMC-Fillins-p0 | DMC-Fillins-pd 2 1 1 112,115 1,15
3 1 1

3 1 2

4 1 0 Renusol_C5__Fich Renusol_C5__Fic 4 1 L8]

4 1 1

4 1 2

5 1 0 clock-2710035_9 clock-2710035 ¢ 2,3 1 [+]

]

In our case we've selected 2 store views.For example, we have English store view (store_id - 1) and
French (store_id - 2). So we can name the same file differently and assign to different categories,
customer groups, etc.

Set Add in 'Import Behaviour' tab.

Press the ‘Import’ button to import stock data.

Validation Results

6 Checked rows: 4, checked entities: 4, invalid rows: 0, total errors: 0

File is valid! To start impert process press "Import" button | Import

It is possible to go back to any of the steps, make changes and regenerate import file if needed. All
changes are saved automatically, and even if the import was not completed, it will be displayed in the
Mass Import Grid so that you could continue importing later.

Testing APl with Postman

You can track and manage all the files of the Product Attachments extension with an APl development
environment - Postman. A handy HTTP client allows to create all necessary queries, put them into
collections, and test apps automatically.

To download a ready-made collection for automated API testing click here:
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collection.zip
API support can be enabled only after purchasing an APl Add-On to Product Attachments extension.

Setting up the Environment

The environment is set up in 3 steps:

1. Open Manage environments form:
as Product Attachments by Amasty )] ¥ & 8

No Environment

et Admin Token

POST ~ . fall/v /integration/admin/tokenzusername=

2. Set the following variables:

e magento_api_url: https://magentourl/index.php/rest
e admin_username: your admin username
e admin_password: your admin password
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MAMAGE ENVIRONMENTS

Environment Name

apimagento

VARIABLE INITIAL VALUE CURRENT VALUE
magento_apl_ur .. | http:f findex.php/rest
admin_username admin

admin_password 2 3222322

@) Use variables to reuse values in different places. The current value is used while sending a request and is

never synced to Postman's servers. The initial value is auto-updated to reflect the current value

behaviour from Settings.

3. Select the created environment:
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28 Product Attachments by A v & Invite

apimagento
» Get Admin Token

POST - fal gration/admin/token?us & d= J } Params Send

The specified variables can be used in further queries.
Backend API Testing: Getting Admin Token

To work with API, you need to authorize and get admin token.

Start a POST request.

Get Admin Token
POST ~

DESCRIPTION

Hit the Send button.

The token will be generated in the response to the request.

apimagento

» Get Admin Token

POST -~ T Jallr T Elnlag &pa - L Params

amasty
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Backend API Testing: Basic Operations

In Magento 2 Product Attachments admin can view, upload, edit and delete files.
In Postman the queries are the following:

* GET
POST
PUT
SEARCH
DELETE

Every time you want to perform operations as an Administrator, you need to authorize with Admin
Token. Insert into the Token field:

{{adminToken}}

mm Product Attachments by Amasty ¥ &, Invite

Upload File

* Upload File

POST ~ falliv1/amasty_product_attachment/filemanage/uploadFile

Authorization

TYPE

Preview Request

Upload the File

To test file uploading, use the POST query. First of all, encrypt the picture in Base64. To upload the
file, insert “string” into “base64_encoded_data”. This is how it reads: “base64 encoded data”:
“string”:
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fall/vi/amasty_product_attachment/filemanage/uploadFile

Body

form-data @ x-www-form-urlencaded binary

XCgoKCwmHCWBQDhY

Body

form-data form-urlencoded

nJGvAMICFAVXITPPALG ril
2FncNPEGHE +2GalGB6htt TBqWshKRSyb!

15w kUkwn
148

Check if the file is uploaded successfully and set it for use in further requests if needed:



https://amasty.com/docs/lib/exe/fetch.php?media=magento_2:product_attachments:product_attachments_api_9.jpg
https://amasty.com

2020/04/04 15:20 35/78 Guide for Product Attachments for Magento 2

a8 Product Attachments by Amasty ¥ & Invite

Upload File

* Upload File

/allv1/amasty_produd_attachment/filemanage/uploadFile

» pm.response.json().temporary_name);

The response is positive, now you can use the uploaded file for testing the Save Uploaded file
query:

Save the Uploaded File

To save the file, use the POST query as well:
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a8 Product Attachments by Amasty ¥ & In

Save Uploaded File

b Save Uploaded File
POST - /all’v1 famasty_product_attachment/filemanage

Body

form-data x-www-form-urlencoded raw

attachment_type™: 8,

tmp_file”: "{{lastUploadedFile}}”,
file_name”: “nameapifile”,
label”: “labelapifile”,
customer_groups”: [

1.
atta::'h'ent_p'cdu:t: : [
5,

B

attachment_categories™: [

L]

4
1,

visible®: t

'
include_in_order”™: true

We add the loaded file “tmp_file” and write out the file data: name, label, etc:
{{lastUploadedFile}}

Before saving the file, make sure it was loaded. Check it with the help of a pre-request script. This
script should be run before the actual request:

a8 Product Attachments by Amasty ¥ &, Invite

5ave Uploaded File

+ Save Uploaded File
POST ~ falliv1/amasty_product_attachment/filemanage
Pre-request Script

{ ! pm.environment.get( " lastUploadedFile™)) {
Error{"Upload File First')
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Unset the uploaded file and configure the settings to use it in the latter requests:

28 Product Attachments by Amasty ¥ & Invite

Save Uploaded File
F Save Uploaded File

POST ~ fall’v1/amas oduct_attachment/filemanage

The file has been saved successfully:

attachment_products®:

Make sure the data on the file match our Magento 2 Product Attachments settings:
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New Attachment A cemouser v

&« Back Save and Continue Edit Save Attachment

File Info Fields

Attachment Type File v

File Upload

sk

Image.png

Attachment Mame * | nameapifile
Label * | labelapifile

Customer Groups NOT LOGGED IM
General
Wholesale

Retailer P

Don't choose any or select all to show the attachment to all customer
Eroups.

isvisible @) ves

Include In Order (: | Yes

Include this attachment inte order transactional email and show in
the ‘view arder’ section of customer's account.

Attach To

Categories A
Add products
1 of 1
ID | Thumbnail | Name Status Type SKU Price Actions
1 Joust Duffle Bag Enabled = simple « 4. $34.00 Remaowe
& MBD1
2 Strive Shoulder Pack Enabled = simple = 24- $32.00 Remaowve
‘ MED4
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You may also save the uploaded file with the help of its URL (using a link field).

Save the File Data by the URL

In this case POST request is also used. Input the URL that points to the file location. Then set the file
name, label, etc., and hit the Send button:

28 Product Attachments by Amasty ~ & Invite

+ Save Uploaded File. Use a link field

POST ~ fall/vi/amasty_product_attachment/filemanage

Body

form-data

The response is positive:
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raw I ET

56861, large.ipg”,

The file has been saved.
Get File Data by the File ID

Get queries let you output the information on a certain file attached to a product. Admin can perform
this operation for Default Store View and for All Store Views.

Let's get the data on LastSavedld with the help of the GET query. Set the URL indicating the needed
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Store View and the file id:

28 Product Attachments by Amasty ~ & Invite

» Get File Data By Id (Default Store View)

GET -~ fdefault/V1/amasty_product_attachment/filermanage/

Authorization

Preview Reguest

Pay attention to a Pre-request Script. Before outputting the info about the file, make sure it has
been saved:

» Get File Data By Id. Default Store View

roduct_attachment/filemanage/

If the file is missing, upload and save it.

Check if the information in the extension settings matches the info for the uploaded file:
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Edit Attachment = .

Store View:  Default Store View [7] € Back Delete File Save and Continue Edit Save Attachment

File Info Fields

Attachment Type Flle -

File Upload

ah

fileNameDefaultstore

Attachment Name = | fileNameDefaultStore

Use Default Value

Label = | labelapifile

Use Default value

Customer Groups NOT LOGGED IN
% General
Wholesale

Retajler

Don't chaose any or select all to show the attachment to all customer groups.

amasty
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Edit Attachment

Is Visible

re view]

Include In Order
[ ew]

sto

w]

Attach To

Use [All Store Views] Categories

Use [All Store Views] Products

Add products

General
Wholesale

Retailer

#

Don't choose any or select all to show the attachment to all customer groups.

Use Default Value

0 ) ves

Use Default Value

MNo

Include this attachment into order transactional email and show in the view order’ section of customer’s account.

Use Default Value

No

€ Back

ID | Thumbnail | Name

3 Crown Summit Backpack

4 Wayfarer Messenger Bag

The response request is positive:
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Fratoy

Search for the File

Postman allows to create search queries by any specific attribute. You can also sort the search results
the way you want to, reorder them and set the number of the results to be displayed in the response
section:

» Search
GET -~ ] fallrvi/amasty_product_attachment/filema (CriteriaffilterGroupsifO]Lfilters][o] d]=filename&: chCriteria[filterGroupsif0][filers][0lvaluel=name¥&searchC...

DESCRIPTION

se

Let's see an example.

You are going to search for the attachment with the name starting with “filename” and with the size
greater than 3000 Bytes. And you want the results to be sorted by id in the ascending order with 5
files per page.

Start with breaking the query into lines:
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{{magento_api url}}/all/V1l/amasty product attachment/filemanage/files?
1. File name starts with “name”:
searchCriteria[filterGroups][0][filters][0][field]=filename&
searchCriteria[filterGroups][0][filters][0] [value]l=name%&
searchCriteria[filterGroups][0][filters][0][conditionType]l=1ike&

2. The size is greater than 3000 Byte:
searchCriteria[filterGroups][0][filters][1l][field]=size&
searchCriteria[filterGroups][0][filters][1][value]=3000&
searchCriteria[filterGroups][0][filters][1][conditionType]=gt&

3. The results are sorted by id in ascending order:

searchCriteria[sortOrders][0] [field]=file id&
searchCriteria[sortOrders][0][direction]=ASC&

4. The number of files per page is 5 and the number of page for viewing is 1:
searchCriteria[pageSize]=5& searchCriteria[currentPage]=1

So 3 files are uploaded , and 2 of them meet the search query:
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r

file_id®: "33",

attachment_type™: 8",

filepath®: "6d2f23ac4396d81cd2cdec2BOel

link™: :

extension™: "jpg”,

sires AT, »
s imagejpeg
: “nameapifile
labelapifile”,

i5_visible®: "1°,

include_in_order”:

customer_groups”:

category_ids": [

e

4

_.i me

],
product_ids":
B
&
1, .
attachment_categories”:

Pt
'

4

1.

attachment_products™:
3,

f

file_id™: "34°,
attachment_type™: 8",
filepath®: "5c75edd42becdBaietBBacedsio2cbfe”,
link™: :

extension™: "3 :
size”: "47937,
mime_type”: “image/j
filename”: “nameapifi
label”™: "labelapifile
i5_visible®: "1°,
include_in_order”:
customer_groups”:
category_ids": [

e

4

]

Er:du:t_id5 g
6",
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Attachment Type File Name File Label Mime Type File Size
33 File nameapifile labelapifile image/jpeg 2317kB
A
34 File nameapifile2 labelapifile2 image/jpeg 468 kB
A
35 File apifile Iblapifile image/jpeg 4.85kB
A
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Delete the File

For example, you've decided to delete the last saved file. So, input the file id in the URL and see if the
file is saved with a pre-request script:

F Delete Saved File
DELETE -~ fall’v1/amasty_product_attachment/filemana;

Pre-request Script

DELETE ~ famasty_product_attachment/filemanage/

Tests

ient.unset("1:

The file is deleted.

Check the result in the extension settings:

[~ | | Icon Attachment Type File Name File Label Mime Type File Size Action
33 File nameapifile labelapifile image/jpeg 2317kB Edit
A
34 File nameapifile2 labelapifile2 image/jpeg 4,68 kB Edit
A
35 File apifile Iblapifile image/jpeg 485kB Edit
A
WE o 1 | Icon Attachment Type File Name File Label Mime Type File size Action
3 File nameapifile labelapifile image/jpeg 23.17kB Edit
A
"] File nameapifile2 labelapifile2 image/jpeg 468kB Edit
A
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Now you are sure the file has been deleted.

Frontend API Testing: Getting Customer Token

While the Backend API testing deals with admin users’ interactions, frontend API testing does the
same for the customers. The operations they perform are not the same.

To test operations that customers perform, you need to log in as a registered customer and get a
customer token.

The algorithm is similar to the process of getting an admin token.

Input the username and password of a test registered customer in the body and click Send:

Params Send A

fintegration/customer/token

Here is the Customer Token.
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F Get Customer Token

POST ~ MNV1/integration/customer/token

Body

form-data x-www-form-urlencoded raw binary

roni_cost@example.com”,
roni_cost3gexample.com

Body

Pretty

SpecmeheccutgmdhodBelssbtilkshzl

Now you can use this token in Tests tab.

apimagento
» Get Customer Token
POST ~ /V1/integration/customer/token Params
Tests

pn.environment.set("customerToken”, pm.response.json()); Test scripts are written in Javascript, and are
»

run after the response is received.

Unlike admin users, visitors and customers can only view or download files. You can test it using Get

amasty
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queries.

Get Files for Product

This test refers to the Default Store View and works with Logged in customers.

To see the attachments of a given product available for a registered customer in a particular Store
View, use the GET method.

Input the Store View and the product ID in the URL:

Get files for Product. Default Store Viey

GET ~ /def il - atta roductid?product id=6 Params. Send bl

Authorization

TYPE

Preview Request

To use the Customer Token you have got previously, input in the Token field:

{{customerToken}}

+ Get files for Product. Default Store View. Logged In customer
GET ~ /defa V1/a ty_product_attachment/g yProduct/d?product_id=6 Params
Authorization

TYPE

Preview Request

Here we see that 2 files are attached to the product with the specified ID:

e The first attachment is available for a registered user:
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Edit Attachment

Store View: Default Store View

File Info Fields

Attachment Type File -

File Upload

ah

1nameFileDefaultSto...

€ Back

Delete File

Save and Continue Edit

Attachment Name * | 1nameFileDefaultStoreView

Use Default Value

Label * | 1labelFileDefaultStoreView

Use Default Value

Customer Groups NOT LOGGED IN
‘ ‘ General
Wholesale

Retaller

g

e The second one is not visible for a registered customer:

Don't choose any or select all to show the attachment to all customer groups.
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Edit Attachment

Store View:  Default Store View w e € Back Delete File

File Info Fields

Attachment Type | File v

File Upload

sk

2nameFileDefaultsto...

Attachment Name * | 2namefFileDefaultStoreView | irg

[store view]

] Use Default Value

Label * | 2labelFileDefaultStoreView
[store view] L

] uUse Default value

Customer Groups_ NOT LOGGED IN
prorevent | General
Wholesale
Retailer

On the frontend it works like this: the registered customer doesn't see the second file:

Home > Fusion Backpack

Fusion Backpack

ook 3 Reviews  Add Your Review

IN STOCK
$59-00 SKU#: 24-MB02

ay
1

Add to Cart

& ADD TO WISH LIST | v «li ADD TO COMPARE &4 EMAIL

Detalls Product Attachments. More Information Reviews (3)

i 1labelFileDefaultStoreView (4.68 ki)

amasty


https://amasty.com/docs/lib/exe/fetch.php?media=magento_2:product_attachments:product_attachments_api_front_8.jpg
https://amasty.com

Last update: 2020/04/04 14:02  magento_2:product_attachments https://amasty.com/docs/doku.php?id=magento_2:product_attachments

The attachment info is displayed correctly:

/default/v1/amasty_product_attachment/getByProductid?product_id=6

Preview Request

Let's check how it works for NO Logged In Customer.

Get Files for Product in Different Store Views

The extension allows to adjust file display according to the Store View.

Here is the example on how it works for Default and, say, Germany Store Views. To test that we need
GET query.

Specify the Store View and the product ID in the URL for Default and Germany Store Views.

Default Store View:

» Get files for Product. Default Store View
GET ~ /default/V1/a duct_atta ] ductid?product_id=6 Params
Authorization

TYPE

Germany Store View:
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Get files for Product. Germany Store View

There are 2 product attachments in the Default Store View:

& Back Delete File  Save and Continue Edit  [RCEVTINIEIGI

File Info Fields

AttachmeneType | File

File | Upload

b

InameFieDefaulSta..

Attachment Name + | InameFileDefaultstoreView

Use Defaul Val

Label + | 1iabelFileDefaultstoreView

Use Defaul Value

Customer Groups | NOT LOGGED IN
General
Whelasale

Retailer

isvisivie @) ves

Use Default Vslue

inctuc inorder (@) Yer

Use Default Value
Attach To

Use [AN Store Views] Categaries @) Yes

Use [All Stare Views] Products No

Add products

10 | Thumbnail | name swtus | Type

Fusion Backpack

Ky | price | Actions

Enableg | simple S5000 | Remove

3
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4 Back  DeleteFile  Saveand Continue Edit  [RERIERCRIIIENTS

File Info Fields

Anachmeni Type | -

Fie | Upload

s

2nameFieDefautSio.

Attachment Name & | 2nam

[ Use Def

Label * | ZabelFileDefauitStoraview

[ Use Defauks Value

Customer Groups | NOT LOGGED IN

General

Whalessie

Retaile

[ Use Defaut Vaiue

[ Use Det

Attach To

Use WA Store views) Cacegories () ves

Use (Al Store Views] Proguets  ((]) Ne.

10| Thumbnal | Mame

6 usion Backpsck

But in the Germany Store View, there is only 1 attachment:

“ L2 € Back  DeleteFile  Save and Continue Egit  [NCEISREIIIITNS

File Info Fields
snscnmens e
'Y
Awachment Name * | 1
o
S
[ Use Defauk Value
T
Attach To

Uso Al toro Views] Caegories @) Ve

Use (AllStore Views] Products () No

Add products
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€ Back

storeview:  Gemary v @

File Info Fields

Attachment Type File

File Upioad

Attachment Name * | Zname

Label # | HabelFileGermanyStoreView

Use Default Vale

Customer Groups NOT LOGGED IN

@ Use Default Vakse

[ Use Default Value

Attach To

Use [All Store Views] Categories () Yes

Use [All Store Views] Products | No

Add products

Thus, the data on attachments for each Store View is displayed correctly:

Default Store View:
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» Get files for Product. Default Store View
(o] = /default/v1/amasty_product_attachment/getByProductid?product_id=6

Authorization

image/jpeg”,

: "1nameFileDefaultStoreView™,
1 "1labelFileDefaultStoreview™,
1 http://apimagento.gabrusevich.ap7l.sty/pub/media/amasty/amfile/icon/Image
http://fapimagento.gabrusevich.ap7l.sty/amfile/file/download,/filef33/

image/jpeg”,

3 2naleFilejefaultStcre?iew ;
: "2labelFileDefaultStoreView”,

L http: f/apimagento.gabrusevich.ap?1.sty/pub/media/amastyfamfileficon/ Image
http://fapimagento.gabrusevich.ap?l.sty/amfile/file/download/Tile/34/

Germany Store View:

+ Get files for Product. Germany Store View
GET - fGermany/V1/amasty_product_attachment/getByProduct/d?product_id=6

Authorization

ew”,
http imay brusevich.ap71.sty/pub/media/amasty/amfile/icon/Image.png”,
rF1°: "http://apimagento.gabrusevich.ap?1.sty/anfile/File/download,file/33/]

Get Files for Product Included in the Order

This query concerns products in the required Store View. On the frontend, these files are displayed on
the Order page.
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Use a GET query. In the URL, specify the needed Store View, in the Params section - product_id,
and include_in_order_only condition: 1 (Yes):

» Get files for Product. Default Store View. ~Include in order” files only

y_product_attachmen >roductlc __id=6&include_in_order_only=1 Params Send X

DESCRIPTION

Authorization

TYPE

As we see, the product with ID=6 in Default Store View has 2 attached files, and Include In Order
condition is met only in the second case:

Fusion Backpack  Back m

Product Reviews ©
Images And Videos ©
Product Attachments ®
1 of 1
Fileld | Icon | File Name Extension | Label Customer Groups Include in Order Visible Actions
33 ™ g No
Use Default
Val -
alue §
34 = Ipg [ @RT
Use Default
Val &
alue §
Product Categories Attachments ©
Search Engine Optimization ©
Related Products, Up-Sells, and Cross-Sells ©
Customizable Options ©

Go to the extension settings. In the Type of Attachments to Display option choose ‘Include In
Order’ Only:
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Order View Page
Yes v

Show Attachments

Title for Attachmen:(s .Elo.ck? Product Attachments

Type of Attachments to Display |, .de in Order only .
Show Filt_a lcon | oo =
Show Filg SIjZE. Yes v

Let's see how the Postman search query will bring the results:

» Get files for Product. Default Store View. ~Include in order” files only

duct_attachments nly= Params

DESCRIPTION

include in order = Yes

Authorization

TYPE

Get Files with Extra URL Parameters

Now we are going to consider the case when outputting the info on attachments in the necessary
Store View needs adding extra parameters to the URL (category, product, order).

As usual, GET query is used.

In the URL, we write the Store View, the ID and the necessary parameters:

» Get files for Product. Default Store View. Add extra url parameters
extra_url_params[cat

DESCRIPTION

This file relates to 2 products:
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dit Attachment « Back  Deletefile  Save and Continue Edit

File Upload

V'S

nameFileAllStoreVie.

Attachment Name * | 1nameFileAllStoreViews
Label * | liabelFileAlStoreViews

Customer Groups NOT LOGGED IN
General
Wholesale

Retailer

4

Dont choose any or select all & shaw the ariachment to allcustomer grougs:
isvisible @) ves

Include norder @) ves

Include this attachment into order transactional email and show in the View order” section of custamer's accourt.

Attach To

Categories =
1 o1 | >
Name stat SKU | Price | Act
5 Rival Field Messenger Ensbled | simple | 24 4500 Rem:
MBOS
[ Fusion Backpack Enabled  simple = 24 $59.00  Remove
‘ MBO2

In each case, the file has a different file_name and label:

Cunngurauuns @)
Configurable products allow customers to choose options (Ex: shirt color). You need to create a simple product for each configuration (Ex: a product for
each color).

Product Reviews @

Images And Videos ©

Product Attachments ®

1 of 1 ?

Include In Order

g

Y nameFileDefaultStoreView_Fusion labelFileDefaultStoreView_Fusion

Use Default value Use Default value Use Defaul v

[ [

Add Existing Attachments Add New

es Add New Links

Product Categories Attachments

Search Engine Optimization

Related Products, Up-Sells, and Cross-Sells
Customizable Options

Product in Websites

© o © © ©
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Rival Field Messenger ¢ Back

Cunngurauuns

i)
Configurable products allow customers to choose options (Ex: shirt color). You need to create a simple product for each configuration (Ex: a preduct for
each color).
Product Reviews ©
Images And Videos ©

Product Attachments

< 1 ‘ of 1 >
Fileld Icon File Name Extension Label Customer Groups Include In Order Visible Actions

33 - ‘nameF\IeDefauI(SloreV\ew,RlvaI ‘ g ‘IabEIFneDEfau\ts\ore\l\ewj\va! ‘

[] Use Default Value [[] use Default Value v

[ [

Add Existing Attachments Add New Files Add New Links

Product Categories Attachments
Search Engine Optimization
Related Products, Up-Sells, and Cross-Sells

Customizable Options

(GINOIINGCIEINORNG

Product in Websites

In case the file is downloaded from the product page, it will have a separate URL for each item:

Kk 3 Reviews  Add Your Review

$59.00 IN STOCK

SKU#: 24-MB02

Qty

1

Add to Cart

W ADD TO WISH LIST 11 ADD TO COMPARE 4 EMAIL

Detalls Product Attachments More Information Reviews (3]

2 labelFileDefaultStoreview Fusion (4.85 kB)

About us Privacy and Cookie ggffcy

@ e your el adies

Customer Service Search Terms

Copyright © 2013-2017 Magento, Inc. Al rights reserved.

apimagento.gabrusevich.ap7 1.sty/amfile/file/download/file/33/product/6/

amasty


https://amasty.com/docs/lib/exe/fetch.php?media=magento_2:product_attachments:product_attachments_api_front_26.jpg
https://amasty.com

2020/04/04 15:20 63/78 Guide for Product Attachments for Magento 2

Home > Gear > Bags > Rival Field Messenger

Rival Field Messenger

*H kP 2 Reviews  Add Your Review

IN STOCK
$45'00 SKU#: 24-MBO6

Qty
1

Add to Cart

W ADD TO WISH LIST Iy ADD TO COMPARE &l EMAIL

Details Product Attachments More Information Reviews (2)

i labelFileDefaultStoreView Rival(4.85 kB)

About us Privacy and gokie Policy SN Enter your mal address

Customer Service Search Tgffns

017 Magento, Inc. All rights reserved.

apimagento.gabrusevich.ap71.sty/amfileffile/download/file/33/product/s/

In Postman, if we make queries to extract the info on the attachment using the product ID only, the
URL will be the same for each item:
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k Get files for Product. Default Store View. Add extra url parameters

GET ~ /default/V1/amasty_product_attachment/getByProductid?product_id=6

Authorization

Body
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bk Get files for Product. Default Store View. Add extra url parameters
GET ~ fdefault’v1/amasty_product_attachment/getByProductld?product_id=5

KEY

product_id

Authaorization

image/jpeq”,

|
=T
we DI pdileg
Bk
m o m

nameFilelefaultStoreView_Rival”,
labelFileDefaultStoreView Rival®,
url™: “http://apimagento.gabrusevich.ap?l.sty/pub/media/amasty/amfile/icon/Image.png”,
http://apimagento.gabrusevich.ap7l.sty/amfile/file/download/file/33/

b I I I I

The main benefit of extra URL parameter is that we get one file with different settings for each
product:



https://amasty.com/docs/lib/exe/fetch.php?media=magento_2:product_attachments:product_attachments_api_front_30.jpg
https://amasty.com/docs/lib/exe/fetch.php?media=magento_2:product_attachments:product_attachments_api_front_30.jpg
https://amasty.com

Last update: 2020/04/04 14:02  magento_2:product_attachments https://amasty.com/docs/doku.php?id=magento_2:product_attachments

b Get files for Product. Default Store View. Add extra url parameters
GET ~ fdefault/V1/amasty_product_attachment/getByProductid?product_id=6&extra_

KEY

product_id

extra_url_params[product]

Autharization

image/jpeg”,

2 1+

== OU o
I N2

m m o
m m

nameFileDefaultstoreView Fusion”,
labelFileDefaul tStoreView_Fusion®,
icon_url”™: “http:/fapimagento.gabrusevich.ap7l.sty/pub/mediafamasty/amfile/icon/Image.png”,
url®™: “http://apimagento.gabrusevich.ap?l.sty/amfile/file/download/file/33/product/6/

fi
i

=1}
[=
(a1}
—
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» Get files for Product. Default Store View. Add extra url parameters

GET - /default’v1/amasty_product_attachment/getByProductid?product_id=58&extra_url_params[prod

KEY
product_id

extra_url_params[product]

Authorization

/ipeg”,
na‘eIFi.1.23efauLtStcre“."iea‘_ﬂi-:al :
: “labelFileDefaultStoreView Rival”, i .
1 http://apimagento.gabrusevich.ap7l.sty/pub/mediafamasty/anfile/icon/Inage.png”,
http://apimagento.gabrusevich.ap7l.sty/amfile/file/download/file/33/product/5/

Another option of Product Attachments is that users can also output or view the data on the files
attached to the whole category.

Get Files for Categories

Now let's output the information on the files attached to a Category of the necessary Store View,
using GET request. The store view is Default:
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» Get files for Category. Default Store View. Everything is the same as product

fdefault/V1/amasty_product_attachmer ByCategoryld?ca

Authorization

» Get files for Category. Default Store View. Everything is the same as product

fdefault/V1/amasty_product_attachmer

Authorization

In the URL, specify the Store View and the ID of the categories we aim to extract file info from. Here
are the expected results based on the module configuration:

e File 1 is attached to the ID 4 category:
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Store View:  Default Store View v 0 <« Back C
File Info Fields
Attachment Type File >
File Upload
.
1nameFileDefaultSto...
Attachment Name +# | 1nameFileDefaultStoreView
Use Default Value
Label # | llabelFileDefaultStoreView
Use Default Value
Customer Groups NOT LOGGED IN
General
Wholesale
Retailer
£
Don't choose any or select all to show the attachment to all customer groups
Use Default Value
| Use Default Value
Include Inorder @ ) ves
Include this attachment intm order transactional email and show in the View order” section of customer's account.
Use Default Value
Attach To
Use [All Store Views] Categories 1M No
Categories Bags | -

e File 2 is attached to the ID=4,5,6 categories:
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Store View:  Default Store View v (7]

File Info Fields

Attachment Type File | *

File Upload

e

2nameFileDefaultSto...

+ Back

Del

Attachment Name * | 2nameFileDefaultStoreView

Use Default Value

Label # | 2labelFileDefaultStoreView

Use Default Value

Customer Groups NOT LOGGED IN
General
Whaolesale

Retailer

2
Dan't choose any or select all to show the attachment to all customer groups.

Use Default Value

| Use Default Value

Include this attachment into order transactional email and showr in the view order’ section of customer’s account.

| Use Default Value

Attach To

Use [All Store Views] Categories () ) Mo

5 6

Categories || Bazs x || Fitmess Equipment x || Watches x

Now we should check how the info is rendered in Postman:

¢ |D 4 Category:
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» Get files for Category. Default Store View. Everything is the same as product

GET ~ /defaultvv1/ama duct_attachment/getByCategoryld?ca

Authorization

¢ |D 5 Category:
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» Get files for Category. Default Store View. Everything is the same as product
GET ~ fdefault/V1/amasty_product_attachment/getByCategoryld?category_id=5

Authorization

i._'age,-"jpeg .
Lle_ : "ZnameFileDefaultStoreView",
label™: "2labelFileDefaultStoreView",
icon_url™: “http://apimagento.gabrusevich.ap7l.sty/pub/media/amasty/amfile/icon/Image.png”,
url™: “http://apimagento.gabrusevich.ap7l.sty/amfile/file/download/file 34/

We see that there are 2 attachments in the ID 4 category and only one attachment in ID 5 category.
This matches the module settings and the info is correct.

Get Files by File ID

In this case, we are going to extract the file info for the Default Store View, relying on the file ID.

As usual, in the URL, we fill in the Store View and the file IDs - in the Params section:

» Get files by Fileld. Default Store View. Everything is same as product
GET ~ 1 fdefaultVl/amasty_product_attachment/getByFilelds?file_ids[}=33&file_ids[=34&file_ids[]=1111

KEY VALUE DESCRIPTION
file_ids]) 33
file_ids[] 34
file_ids[) 1111

Authorization

TYPE

In our example we see 2 uploaded files:
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Attachments Management Q M@ & amn-

Add New Attachment

W Filters © Def:
Actions 2re ou 20 v | per page

L | Icon Attachment Type File Name File Label

The info is correct:

+ Get files by Fileld. Default Store View. Everything is same as product
GET ~ /default/v1ramasty_product_attachment/getByFilelds?file_ids[]=33&file_ids[]=34&file_ids[]=1111

KEY

file_ids[]
file_ids[]
file_ids[]

Authorization

image/jpeg”,
: 1na:eFtleJefaultStcrﬁﬁiew !
1labelFileDefaultStoreView”,
http://apimagento.gabrusevich.ap7l.sty/pub/media/anasty/anfile/icon/Inage
http://apimagento.gabrusevich.ap?l.sty/amfile/file/download/file/33/

image/jpeg”,
éhajeFile3efaultStcreUiEﬁ :
2labelFileDefaultStoreView”,

http://apimagento.gabrusevich.ap7l.sty/pub/media/amasty/anfile/icon/Image
http://apimagento.gabrusevich.ap?l.sty/amfile/file/download/file/ 34/

We have added the ID of a non-existing file (1111) on purpose. As you can see, Postman didn’t report
any error. The tool just output the existing files.

amasty



https://amasty.com/docs/lib/exe/fetch.php?media=magento_2:product_attachments:product_attachments_api_front_40.jpg
https://amasty.com

Last update: 2020/04/04 14:02  magento_2:product_attachments https://amasty.com/docs/doku.php?id=magento_2:product_attachments

Test File Downloading

To do this, output the info in Base64 format. Then copy the Base64 code and insert it into decoders
to get the product picture. Use GET query to output the file data:

F Get File Content (Download)

GET ~ roduct_id=&category_id=

KEY

file_id

product_id

Authorization

In the URL input the necessary Store View, in the Params section - the file/product/category ID.

There are several ways to get the file content. We provide the file settings in the module settings and
their representation in Postman.

e Using the file ID:
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Edit Attachment Q M0 & -

Store View:  Default Store View (7] € Back Delete File Save and Continue Edit Save Attachme

File Info Fields

Attachment Type File -

File Upload

ah

1nameFileDefaultsto...

Attachment Name # | 1namefFileDefaultStoreView

Use Default Value

Label # | 1labelFileDefaultStoreView

Use Default Value

Customer Groups NOT LOGGED IN
' General
Wholesale

Retaller

4

Don't choose any r select all to show the attachment to all customer groups.

Product Attachments by Amasty ~ & Invite

Collections y
» Get File Content (Download)

GET

DESCRIPTION

nd Api

Body

Pretty

{

¢ Using the file/product ID:
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Fusion Backpack PRPRORN A Attribute “
Lontent )]
Configurations @

[nn;\gulrak;\e products allow customers to choose options (Ex: shirt color). You need to create a simple product for each configuration (Ex: a product for
each color).

Product Reviews

©
Images And Videos ©
Product Attachments @
1| of1
Icon | File Name Extension | Label stomer Groups Include In Order Actions.
2 A nameFileDefaultStoreView_Fusion L labelFileDefaultStoreView_Fusion
Use Default Value Use Default Value

<

"
Product Categories Attachments (@)
Search Engine Optimization @
Related Products, Up-Sells, and Cross-Sells @
Customizable Options ©

&8 Product Attachments by Amasty ¥ & Invite

Collections
Get File Content (Download)

DESCRIPTION

¢ Using the file/category ID:
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Bags (ID: 4) Q M@ X amn-

Store View:  DefalltStore View ~ o Delete m

~ Yousaved the category.

Collapse A
Default Category
What's New (0) ¥l Use Default Value
Women (0)
Men (0)
Gear (46)
Bags (14) -
Fitness Equipment (23) ¥l Use Default value
Watches (3)

Training (6}

sale (0) ¥ Use Default Value

Content

Display Settings

Search Engine Optimization

Products in Category

Design

®© |l ® 6 60 o

Schedule Design Update

Product Attachments

@

lcon | Attachment Name Include In Order Actions

y InameFileDefaultStoreView_Categorys g 1labelFileDefaultStoreView_Category4

Use Default Value Use Default Value

t Attachments by Amasty ~ & Invite ® « £2 0 @
apimagento
¥ Get File Content (Download)

GET ~ attachment/downlo:

DESCRIPTION

Authorization

Find out how to install the Product Attachments extension via Composer.
Rate the user guide
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